
HOUDINI FOUNDATIONS 
SOLARIS MARKET 
In this lesson, you will learn how to use the Solaris Lookdev, Layout and Lighting tools to create a market 
scene using existing assets. The Solaris environment converts everything into USD [Universal Scene 
Description] which is an open source initiative created by PIXAR. The Solaris/LOPS context allows you to 
work with USD natively using procedural nodes to manage key USD concepts.
You will learn how one artist can publish USD layers or files that can be picked up by the next artist. 
Changes can be added non-destructively to set up a scene or refine a shot. The way USD is used in this 
lesson is for artists who need to benefit from its power without getting mired in its technicalities.

LESSON GOAL
Create a Market scene using existing assets to set up the lookdev, layout and lighting of a shot.

WHAT YOU WILL LEARN
	� Work with USD files at various stages of production. You will take on three roles to complete the shot. 

Lookdev/Asset Prep Artist
	� How to use the Component Builder to prepare and export assets to USD
	� How to Assign Materials and set up Proxy Geometry
	� How to use Set up Variants for assets that will be available during layout

Scene Assembly Artist
	� How to use the Stage Manager to place assets
	� How to work with Instancing to set up assets
	� How to save out a USD file for the assembled scene

Layout/Lighting Artist
	� How to set up a camera and lights and render a shot 
	� How to set up multiple shots with different lighting designs
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COMPATIBILITY
Written for the features in Houdini 20.5

The steps in this lesson can be 
completed using the following 
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PART ONE: 
The Component Builder
To start, you are going to focus on asset preparation. This is where you bring together the 
geometry and textures to create a USD-based asset.  To do this, you will use the Component 
Builder which makes it easier for artists to create first class USD that will work reliably through-
out all of the stages of the pipeline. 

01 Select File > Set Project.  Find the market_lesson directory 
that you downloaded and press Accept. This makes 

this project directory and its sub folders the place for all the files 
associated with this shot. 

Select File > Save As... You should be looking into the new  
market_lesson directory. Set the file name to market_assets.hip and 
click Accept to save. Now you will be able to access the reference 
geometry and images in the source_assets folder.

02 Use the Desktop menu at the top to choose the Solaris 
desktop. This layout reveals panes that are ideal for 

setting up and working with USD-based assets.

In the Network view, press tab > Component Builder and click to 
place the network down.

03 Double-click on the componentgeometry node to dive 
into it then press tab > File and click to place the node. 

Next to Geometry File click on the File Chooser button. Go to the 
$HIP/source_assets/bucket directory and get the bucket.bgeo file. 
Wire the file node into the default node.

04 Go back to the Stage level. Delete the materiallibrary 
node. Select the componentmaterial node. Click on the 

Add Quick Material button and select Quick Surface Material. 
Select the new node and name it bucket_mtl.

In the Base section, click on the icon on the left of the Color Map 
field and choose Set or Create. Next to Color Map click on the File 
Chooser button. Go to the $HIP/source_assets/bucket/bucket_tex 
directory and get the bucket_BaseColor.png file. 
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06 Rename componentoutput to bucket. Go back into bucket 
node and add a PolyReduce node just above the proxy 

node. Feed the file node into it then feed the polyreduce node into 
the proxy and simproxy outputs. Set the Display Flag on the proxy 
node.

On the polyreduce node, set Percent to Keep to 5 and turn on Use 
Only Original Point Positions and Preserve Quads. Now you have 
lower resolution geometry that can be used for optimizing viewport 
speed and to assist with using dynamics to layout your geometry.

07 Set the Display Flag on the default node. Go back to the 
stage level . In the Scene Graph you can now see that 

Proxies have been added. 

Select the bucket node and press on Save to Disk.

This creates a series of files on disk and copies over the texture 
files to consolidate all the parts of the asset. The geometry has now 
been saved out as usdc files.

08 Press tab > Sublayer and place the node . Click on the 
File chooser button and go to usd/assets/bucket and 

choose bucket.usd. Set this node’s Display Flag and check out the 
Viewport and Scene Graph.

You will now see that the Scene Graph has the USD prims 
organized in the same way as you set it up with the component 
builder. 

WORKING WITH USD IN SOLARIS?
To access USD, you are now going to work to Solaris which is the Lighting Operator or LOP 
context in Houdini. The Solaris environment can be found in the /stage network. 

Here you will place nodes for bringing in geometry, assigning materials and adding lights 
and cameras. The Solaris environment converts everything into USD [Universal Scene 
Description] which is an open source format created by PIXAR. The Solaris/LOPS context 
allows you to work with USD which is needed to render to the Karma XPU renderer.
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05 Set Metalness to 0.7 then use this same method to set 
the Metalness Map to bucket_Metallic.jpg. 

Set Specular > Roughness to 0.5 then set the Roughness Map to 
bucket_Roughness.jpg.

Go to the Bump section and set Bump Style to Height then set the 
Bump Normal Map to bucket_Height.jpg. Leave Bump Scale set to 
0.025.

From the Persp menu in the Scene View, choose Karma XPU. This 
turns on the renderer in the viewport. When you tumble around 
the view will re-render quickly.



10 Lets set up a cooking pot asset. In the Network view, 
select the four component builder nodes and Alt-drag to 

make copies. Rename the Edit Material Properties node to cooking_
pot_mtl and the Component Output node to cooking_pot. Set the 
Display flag on cooking_pot.

Dive into componentgeometry node and select the file node. Next 
to Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/cooking_pot directory and get the cooking_pot.bgeo 
file. On the Polyreduce node, set Percent to Keep to 30. This makes 
sure there is enough detail.

09 Add a Grid node and name it ground. Double click to dive 
down to the geometry level. Select the grid node and set 

Size to 100, 100. Press u to go back to the stage level. 

Add a Karma Physical Sky node and set Intensity to 2, Solar 
Altitude to 30 and Solar Azimuth to around 180.

Check out Scene Graph pane. You will see the ground, the bucket 
and light. These are all the parts being rendered. You will use this 
network to test all the assets as they are created.

11 Go back to the Stage level. Change the cooking_pot_mtl 
with the following: 
	� Base >Color Map to cooking_pot_BaseColor.jpg
	� Base > Metalness to 0.8
	� Metalness Map to cooking_pot_Metallic.jpg
	� Specular > Roughness to 0.4
	� Roughness Map to cooking_pot_Roughness.jpg
	� Bump > Bump Style to Height
	� Height Map to cooking_pot_Height.jpg
	� Bump > Bump Scale to 0.01

12 Select the cooking_pot node and press on Save to Disk. 

Select the Sublayer node you used earlier to test the 
bucket. Click on the File chooser button and go to usd/assets/
cooking_pot and choose cooking_pot.usd. Set the karmaphysicalsky 
node’s Display Flag and check out the Viewport and Scene Graph.

WHAT ARE PRIMS?
USD defines a Prim [Primitive] as "the primary container object in USD: 
prims can contain (and order) other prims, creating a “namespace hierar-
chy” on a Stage, and prims can also contain (and order) properties that hold 
meaningful data. Prims, along with their associated, computed indices, are 
the only persistent scenegraph objects that a Stage retains in memory."  

In Solaris, the nodes often find the prims automatically but in some cases 
you need to point to the prim path explicitly.
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QUICK SURFACE MATERIAL
The Quick Surface material is a shader that was built up using MaterialX nodes then exported 
as USD. Because it is already USD, it processes efficiently when you render. The Quick Sur-
face Material loads this USD file into an edit node where you can change its name and assign 
different values and texture maps. 

For assets that have texture maps prepared, this is the best material to use because of its ef-
ficiencies. If you need a material that is more complex then you can build it up yourself using 
the Karma/MaterialX Builder nodes in VOPS.

14 Go back to the Stage level. Set the Display Flag on the 
table node. Change the table_mtl with the following: 
	� Base >Color Map to table_BaseColor.jpg
	� Base > Metalness to 0.8
	� Metalness Map to table_Metallic.jpg
	� Specular > Roughness to 0.4
	� Roughness Map to table_Roughness..jpg
	� Bump > Bump Style to Normal
	� Normal Map to table_Normal.jpg
	� Bump > Bump Scale to 2 

15 Select the table node and press on Save to Disk. 

Select the Sublayer node you used earlier to test the 
bucket and cooking pot. Click on the File chooser button and go 
to usd/assets/table and choose table.usd. Set the karmaphysicalsky 
node’s Display Flag and check out the Viewport and Scene Graph.

16 On the Display Options bar, click on the Control Visibility 
of Primitives button and choose Preview to look at the 

Proxy geometry and Final Render to show the higher resolution 
geometry. For now keep this at Final Render. The proxy geometry 
will become more important in the Layout stage.

13 Lets set up a table asset using the same steps. In the 
Network view, select the four cooking_pot component 

builder nodes and Alt-drag to make copies. Rename the Edit 
Material Properties node to table_mtl and the Component Output 
node to table. Set the Display flag on table.

Dive into componentgeometry node and select the file node. Next 
to Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/table directory and get the table.bgeo file. On the 
Polyreduce node, set Percent to Keep to 20. 
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18 Go back to the stage level and check Scene Graph. Just 
like the table there is only one prim. But the tent has two 

parts, the cloth and the supports. 

Dive into componentgeometry node and MMB on the file node. 
You will see that there are groups for these two parts. Press tab > 
Names from Groups and place the node after the file node.  Set the 
Group Mask field to *. Feed this node into the polyreduce node.

Go back up and check Scene Graph. Now you will see two prims 
that will allow you to assign different materials to the parts of the 
tent.

19 Select the tent_mtl node and set the following: 
	� Base > Color Map to tent_BaseColor.jpg 
	� Metalness to 0 - Remove the texture map
	� Specular > Roughness to 0.6
	� Roughness Map to Tent_Roughness.jpg.
	� Remove the Normal map

20 Select the componentmaterial node. Click on the Add 
Quick Materials button and select Quick Surface 

Material to add a second one. Rename it support_mtl.

Select the support_mtl node and set the following: 
	� Base > Color Map to supports_BaseColor.jpg 
	� Metalness to 0.8
	� Base > Metalness Map to supports_Metallic.jpg 
	� Specular > Roughness to 0.5
	� Bump > Normal Map to supports_Normal.jpg
	� Bump Scale to 1

17 Now lets set up a tent asset which is has a couple extra 
steps. In the Network view, select the four component 

builder nodes belonging to the table and Alt-drag to make copies. 
Rename the Edit Material Properties node to tent_mtl and the 
Component Output node to tent. Set the Display flag on tent.

Dive into componentgeometry node and select the file node. Next 
to Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/tent directory and get the tent.bgeo file. If you can’t 
see the file just type tent.bgeo and press Enter. 

WHAT'S IN A NAME?
The name you give the Root prim is set based on and expression. On the 
Component Output node you will see the Root Prim set to /$OS - this 
means it is using the node name to create /tent. 

In the Caching section, the rootprim is then used to create the Name and 
file name of the USD file. This is all managed with expressions so you don't 
need to change any of the names yourself. Just name the node and the 
expressions set things up for you.
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22 On the Display Options bar, click on the Control Visibility 
of Primitives button and choose Preview to look at the 

Proxy geometry The textures are not assigned because they are 
only assigned to the Render prims.

Edit the Primitives paths to /ASSET/geo/*/Tent and /ASSET/geo/*/
Supports. This will work for both the Proxy and Render leafs.

Click on the Control Visibility of Primitives button and choose Final 
Render to go back to full resolution geometry.

23 Select the tent Component Output node and press on 
Save to Disk. Again you are saving files to disk in the 

proper USD format.

Select the Sublayer node you created earlier . Click on the File 
chooser button and go to usd/assets/tent and choose tent.usd. 
Set the karmaphysicalsky node’s Display Flag and check out the 
Viewport and Scene Graph.

24 Expand the Network view to full screen by clicking on 
the button in the top right. Now select all the nodes for 

the bucket and click on the Network Box button. Double click 
on the title bar and name it Bucket. Repeat for the table, tent and 
cooking pot. You can also create a Network box for the sublayer, 
ground and karmaphysicallight and name it Test.

It is always a good idea to keep your network organized to help find 
the right nodes later.

Save your work. 

21 The componentmaterial node automatically assigns 
the right and left inputs. That is what the lopinputprims 

expression is doing. Because you have two materials, you need to 
assign the primitives directly.

Click on the arrow next to Primitives and in the Scene View set 
Kind to Leaf Primitives. Click on the ground to deselect then click 
on the fabric part of the tent and press Enter. Click on the arrow 
next to Material Path. Choose mtl > tent_mtl and press Enter.

Click the Plus sign next to Material Assignments and set Primitives 
to Supports and the Material Path to mtl > support_mtl.

INSPECTING THE USD
Right-click on the Component Output node, open the LOP Actions 
sub-menu, and choose Inspect active layer. This opens a viewer window 
showing the layer as usda code. This is an example of the USD that you 
will be saving to disk when you press the Export button.
Artists don't need to know about this level of USD. The Solaris nodes in 
Houdini will set this up for you. But if you want to take a deeper dive into 
the USD code then this gives you a preview.
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02 Go back to the Stage level. Select the barrel_mtl Quick 
Surface Material node and set the Base > Color Map to:
	� barrel_1001_BaseColor.jpg 

This looks a bit strange because the barrel uses UDIM textures. You 
need to edit the texture name to grab both of the textures. Change 
the name to:

	� barrel_<UDIM>_BaseColor.jpg

Note that the UDIM textures don’t display properly in Houdini VK 
therefore you should preview these with Karma XPU.

03 For the rest of the textures, load the 1001 version then 
edit it to <UDIM>.

Set the following:
	� Base > Metalness to 0.8
	� Metalness Map to barrel_<UDIM>_Metalic.jpg
	� Specular > Roughness to 0.6
	� Roughness Map to barrel_<UDIM>_Roughness.jpg
	� Bump > Bump Style to Height
	� Roughness Map to barrel_<UDIM>_Height.jpg
	� Bump > Bump Scale to 0.05

04 Rename the Component Geometry node to lid. Alt-drag 
the lid node to create a second node. 

Name this one nolid. Double-click to dive into this node and after 
the file node, add a Visibility node and set:

	� Group to Lids
	� Apply to to Non-Selected Primitives

With the Select tool, box select the top lid of the barrel. 

01 Lets set up a barrel asset that uses variants. In the 
Network view, select the bucket network box and 

Alt-drag to make a copy of the box and the nodes inside the box. 
Rename the Edit Material Properties node to barrel_mtl and the 
Component Output node to barrel. Rename the network box to 
Barrel. Set the Display flag on barrel.

Dive into componentgeometry node and select the file node. Next 
to Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/barrel directory and get the barrel.bgeo file. On the 
Polyreduce node, set Percent to Keep to 10. 

PART TWO: 
Create Assets with Variants
The next few assets will be set up using Variants. Variants are different versions of an asset which have unique geometric or 
material qualities. The component builder lets you set up all the different variants then incorporate them into the USD file. 
Later you will have access to the variants during scene assembly and layout. 
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07 Open up the Export Options section and turn on Variant 
Layers. Make sure Variant Set is set to geo. This adds a 

directory for your variants and store them as individual USD files. 
Press Save to Disk. 

Select the sublayer node you created earlier. Click on the File 
chooser button and go to usd/assets/barrel and choose barrel.usd. 

08 Add an Explore Variants node and feed the sublayer node 
into it. Set the following:
	� Variant Set Filter to geo
	� Mode to Explore Variants
	� Layout to Side by Side
	� Spacing to 0.5

Wire the explorevariants node into the existing ground surface and 
karmaphysicalsky. Here you can review the two variants. You will 
use the variants later in the layout stage of the project.

06 Go back to the stage level. Add a Component Geometry 
Variants node after the lid node. Feed nolid into this 

node.

Set the Display Flag on the barrel node. Turn on Set Default 
Variants and use the menu on the right to set Geometry to nolid or 
lid. You can see the variant changing in the Scene view. Choose lid 
as the default.

05 Press Delete to blast that geometry. Set the Bypass Flag 
on the visibility node to bring back the rest of the barrel

The visibility node lets you hide geometry without changing the 
point and primitive numbers. This way you can hide parts of the 
barrel to make it easier to delete the top lid. When you bypass the 
node, the sides come back.

This new geometry should feed into the polyreduce and therefore 
works the same as the barrel with the lid.

UDIM TEXTURES
UDIM is a system for dividing texture space into multiple “tiles” in UV space, with 
each tile represented by a separate texture file on disk. You can specify a texture 
name like foo<UDIM>.exr and any UDIM-aware renderer or image loading node will 
know to replace the <UDIM> token with the address of the UV tile.

Separating UV space into different texture files lets you use high-resolution files for 
large, detailed islands, and low-resolution files for small or simple islands. It can also 
have benefits for file and memory cache locality.
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11 Go back to the Stage level. Select the clay_mtl node and 
set the following: 
	� Base > Color Map to pot_clay_BaseColor.png 
	� Base > Metalness to 0.5
	� Metalness Map to pot_clay_Metallic.png
	� Specular > Roughness to 0.4
	� Roughness Map to pot_clay_Roughness.png
	� Bump > Bump Style to Height
	� Roughness Map to pot_clay_Height.png
	� Bump > Bump Scale to 0.1

12 Alt drag on the material node to create a second Quick 
Surface Material node and rename it metal_mtl. Place 

it between the clay_mtl node and the componentmaterial node. 
Change the following: 

	� Base > Color Map to pot_metal_BaseColor.png 
	� Base > Metalness to 0.8
	� Metalness Map to pot_metal_Metallic.png
	� Roughness Map to pot_metal_Roughness.png
	� Height Map to pot_metal_Height.png
	� Bump > Bump Scale to 0.25

10 On the polyreduce node, set Percent to Keep to 30. If you 
go lower with this then to much detail is lost on the pot.

Set the Display Flag on the default node.

09 Now let's create a pot asset where the variation is in the 
material not the geometry.  In the Network view, select 

the bucket network box and Alt-drag to make copies of all the 
nodes. Rename the Edit Material Properties node to clay_mtl and 
the Component Output node to pot. Set the Display flag on pot. 
Rename the network box to Pot.

Dive into componentgeometry node and select the file node. Next 
to Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/pots directory and get the pot.bgeo file. 

EXPLORE VARIANTS
USD allows primitives to have variants: separate named groups of proper-
ties you can switch between. This is often used to switch between differ-
ent geometry rand material representations of a prim. For example, a Lamp 
prim might contain variants representing different sizes and styles of lamp, 
allowing the layout artist to choose one appropriate to the scene.

The explore variants node lets you expand out the variants and see them 
side by side. This helps you determine if they were set up properly.
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15 Now let's create variants of books that have different 
shapes and different texture maps. In the Network view, 

select the bucket network box and Alt-drag to make copies of all 
the nodes. Rename the Edit Material Properties node to book_mtl1 
and the Component Output node to book. Set the Display flag on 
book. Rename the network box to Book.

Dive into componentgeometry node select the file node. Next to 
Geometry File click on the File Chooser button. Go to the $HIP/
source_assets/books directory and get the book1.bgeo file. 

16 On the polyreduce node, set Percent to Keep to 10 and 
turn on Use Only Original Point Positions and Preserve 

Quads. Now you have lower resolution geometry that can be used 
for optimizing viewport speed and to assist with using dynamics to 
layout your geometry.

Set the Display Flag on the default node.

14 Select the pot node.  Open up the Export Options section 
and turn on Variant Layers. Open this section and set 

Variant Set to mtl. Press Save to Disk.

Select the sublayer node you created earlier. Click on the File 
chooser button and go to usd/assets/pot and choose pot.usd. This 
will feed into the Explore Variants node you set up earlier. Set the 
following:

	� Variant Set Filter to mtl
	� Spacing to 0.3

You can review the two variants. 

13 Rename the Component Material node to clay. Click on 
the arrow next to Material Path and choose clay_mat.

Alt-drag on this node to create a second Component Material node 
and place it after the first one. Rename it to metal. Click on the 
arrow next to Material Path and choose metal_mat.

Rename componentoutput to pot. Set the Display Flag on this node. 
Turn on Set Default Variants and set Material to metal. 

17 Go back to the Stage level. Select the book_mtl1 node and 
set the following: 
	� Base > Color Map to book1_BaseColor.png 
	� Base > Metalness to 0.8
	� Metalness Map to book1_Metallic.png
	� Specular > Roughness to 0.4
	� Roughness Map to book1_Roughness.png
	� Bump > Bump Style to Height
	� Height Map to book1_Height.png
	� Bump > Bump Scale to 0.025
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20 Select the two, book_mtl2 and bookassign2 nodes.  Alt-
drag to create three more copies of all of these nodes. 

Name these new nodes to numbers three, four and five. 

Double-click to each Component Geometry node and change the 
file node to the related number. Book five is oriented differently. 
At the stage level, add a Transform node after the Component 
Geometry node, set Primitives to /ASSET/geo/*/shape and then set 
Rotate Y to 90. This will align it to the other books

Change the texture maps on the Edit Material Properties nodes. 
Feed the new bookassign nodes into the Component Variant node. 

18 Rename the Component Geometry node to one and the 
Component Material node to bookassign1. 

Select the 1, book1_mtl and bookassign1 nodes.  Alt-drag to create 
copies of all of these nodes. Name these new nodes two, book2_mtl 
and bookassign2.

Double-click to dive into the two node and change the file node to 
book2.bgeo. Go back to the stage level. On book2_mtl, change the 
maps to the book2 maps in the book2_textures folder. 

19 Add a Component Geometry Variants node after the 
bookassign1 node. Feed bookassign2 into this node. 

On the book Component Output node, turn on Set Default 
Variants and use the menu on the right to set Geometry to one or 
two. You can see the variant changing in the Scene view. Choose 
one as the default.

21 Select the book node.  Open up the Export Options 
section and turn on Variant Layers. Press Save to Disk. 

Select the sublayer node you created earlier. Click on the File 
chooser button and go to usd/assets/book and choose book.usd.

On the Explore Variants node, set the following:
	� Variant Set Filer to geo
	� Layout to Side by Side
	� Spacing to 0.3

ASSET AUTOMATION
For this lesson, you are creating each asset using the Component builder nodes. 
This means importing geometry and setting up the Quick Surface material. A more 
advanced technique would be to automate this using PDG or Task Operators. This 
would need to be set up to match the particular nature of your asset pipeline but 
has the possibility to let you rapidly process multiple assets.

This is something you can learn down the line. For now it is a good idea to set up 
each of the assets directly so that you understand how this process works.
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24 Next set up these baskets. This setup will again be similar 
to the setup used with the books.

Set the Component Output node’s name to basket and the 
Component Geometry nodes to carpets, large, large_handles, lid_
only, small and small_lid. 

When you test the asset using the sublayer node setup, you will 
need to adjust the Spacing on the Explore Variants node.

25 Next set up these jars. This setup will again be similar to 
the setup used with the books.

Set the Component Output node’s name to jar and the Component 
Geometry nodes to tall-lid, tall_lid_cloth, tall_lid_herbs1, tall_lid_
herbs2 tall_lid_herbs3 small_handle, and small_lid1.  When setting up 
the textures note that some jars use UDIMS and will need <UDIM> 
in place of the texture number.

When you test the asset using the sublayer node setup, you will 
need to adjust the Spacing on the Explore Variants node.

Save your work.

23 Next set up these three broomsticks. This setup will 
again be similar to the one used with the books.

Set the Component Output node’s name to broom and the three 
Component Geometry nodes to stick1, stick2 and stick3. 

When you test the asset using the sublayer node setup, you will 
need to adjust the Spacing on the Explore Variants node.

22 Use the techniques taught in previous steps to set up 
these two shelves. This setup will be similar to the setup 

used with the books.

Set the Component Output node’s name to bookcase and the two 
Component Geometry nodes to shelf1 and shelf2. 

When you test the asset using the sublayer node setup, you will 
need to increase the Spacing on the Explore Variants node.

USD FILES ON DISK
The assets you have prepared have been stored on disk in the project 
directory in usd > assets. Each asset has a directory with all the files neces-
sary to properly represent the geometry, materials, payloads and variants. 

The texture files have been moved into this directory structure. The main 
USD file is the one you have been using with the Sublayer node and it is 
the root of the whole asset.
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04 Change your desktop to Solaris. Bring back the Layout 
Asset Gallery in the bottom right pane. Drag the Tent 

asset from the gallery to the Scene View. Turn off the Reference 
Grid and press D and set the background to dark. Use the view 
tools to focus on the Tent. 

The Visibility of this scene is focused on the Proxy geometry you 
set up earlier. That can be changed later. The scene will be set up 
quicker with the proxies.

02 Click on the gear icon and choose Create New Asset 
Database File. Name the database File to market_usd_

assets and press Accept. 

Now click on the Add Asset Directory button. Click on the File 
selector button next to Directory. Go into the USD directory and 
press Accept. In the Variant Sets section enter geo mtl. Press OK.

Houdini is going to go and create thumbnails for all the assets in 
that directory and add them to the gallery.

03 When they are ready, you will see all the assets and 
variants in the gallery for you to use to layout the scene. 

In this panel, you can star assets that you think are important and 
filter by name in the top right.

This gallery can be loaded into any scene as you need it. This way 
multiple artists can access the same USD files.

01 Select File > New. Select File > Set Project.  Find the 
market_lesson directory and press Accept. Then Select 

File > Save As. Click on $JOB to get the project directory and set 
File to market_scene_assembly.hip and then press Accept. You 
are now going to work with the assets created earlier as a scene 
assembly artist. 

In the top right pane, click on the plus sign next to the tabs and 
select New Pane Type > Solaris >Layout Asset Gallery. This brings 
up a gallery with some default assets. 

PART THREE: 
Work with the Layout Gallery
You now have assets that have been properly set up as first-class USD. For this part of the lesson, you will play the part of an 
assembly artist who is going to create a scene out of the kit of parts you just prepared. This will give you a sense of how differ-
ent artists on the same team can work together using USD in Solaris. 
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08 From the Layout Gallery, drag the two bookcases into the 
scene Select them in the Network view with the Handle 

tool active and move them to the back of the tent. You need to 
have the node for each of then selected when you move it,

Add the geo group to both of their Destination Paths.

06 In the Network view, select the tent node then get the 
Handle tool. Now you can transform the tent to rotate it 

a little. Be sure not to lower the tent below the ground. 

This reference node lets you change the transforms on the asset.

07 Add a Grid node. Name it ground and feed it into tent 
node. Set the Import Path Prefix to /geo/$OS. This will 

give you a surface to work off of when you start adding more 
assets.

05 In the Parameter pane, set Destination Primitive to /geo/
tent. In the Scene Graph, you can see that the tent is now 

part of a geo group.

Drag the table from the gallery into the Scene view and set its 
Destination Primitive to /geo/table. You now have two assets 
inside the geo group. 

REFERENCE VS SUBLAYER
USD has two different approaches to loading the contents of another USD file: sub-layering 
overlays the tree of the imported file over the current tree, while referencing attaches the 
contents of the imported tree as a branch on the existing tree.

Sublayering composes different versions of the whole scene. For example, overlaying the 
lighting department’s version of the scene with final lighting over the layout department’s 
version of the scene with scratch lighting. Referencing adds a part to the scene. For example, 
importing props to begin layout like you just did with the market assets.
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04 Add a Group node to the end of the chain and set its 
Display Flag. Press the arrow next to Base Group and 

press 4 in the Scene view to get Primitive selection.

Double-click on one of the shelves. Press shift and double click on 
all the other shelves until you have all 12 selected then press Enter. 
The side boards should not be selected.

Turn on Enable under Keep by Normals then set the following: 
	� Direction to 0, 1, 0
	� Spread Angle to 30

Set the Group Name to shelves. The top surfaces are isolated.

02 Double-click on the Instancer node to 
dive into it. Press tab > LOP Import and 

place down the node. You are at the geometry 
level and need to bring the bookshelves into this 
node. Click on the node selector next to LOP Path 
and choose the bookcase__shelf1_ node. Click on the Arrow next to 
Primitives and select /geo/bookcase__shelf1_. 

Right now you can see the whole scene. Click on the Visibility pull 
down in the top right of the Scene View and choose Hide Other 
Objects. This will isolate the bookcase from the rest of the scene.

03 Select the lopimport node and Alt-drag to create a 
second one. Edit the LOP Path to bookcase__shelf2_ 

and Primitives to /geo/bookcase__shelf2_.  Add a Merge node to 
the network and feed the two lopimport nodes into it then set its 
Display Flag.

Next press tab > Unpack USD to Polygons. This will convert the 
USD into polygons that you can use to set up the instancing points. 

01 In the Network view, press tab > Instancer and place the 
node at the end of the chain then feed the output of the 

bookcase__shelf2_ node into it and set its Display Flag.

Set its Primitive Path to /geo/bookcase_jars. 

There is an error right now because all the parts are not hooked 
together. You will set up points inside this node to copy the jars.

PART FOUR: 
Instance Jars on the Bookcases
You now have two bookcases that are sitting empty. You are going to populate these shelves with jars using instancing. You will 
start by pulling the shelves into the geometry level where you will scatter points on the shelves. This provides a very efficient 
workflow for dealing with many similar objects. You will also add some variation to the size and orientation of the jars.. 
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09 Add a Collection node after the stagemanager node. Set 
the Collection name to Jars and set Primitives to /jars/*.

Wire the collection node into the second input of the instancer 
node. On the Instancer node, remove the text from Prototype 
Primitives then from the menu on the right choose Collection: Jars 
to set it to %Jars. Set the Display flag on the instancer node and in 
the Scene view you can see some jars set up on the shelves. 

To focus on the shelves, click on the eye icon next to ground, table 
and tent in the Scene Graph. You can bring them back later. You can 
also set the Visibility to Final Render to see the full geometry.

07 Go up one level to the Stage Level.  In the Network view 
press tab > Stage Manager and place the node off to 

the side without wiring it into anything. In the Scene Graph Path 
section, hover over the / path and a + sign appears. Click on the 
plus sign which creates a group node. Double-click on the group 
and rename it jars.

08 Now click on the Asset Catalog tab and the Layout 
Gallery is available as part of this node. Expand the 

Parameter pane so you can see all the assets. Shift select all of the 
jar assets and drag them onto the jar group. This will make them 
available to the instancer node.

06 Add a Blast node to the end of the chain and set its 
Display Flag. From the arrow next to Group, select shelf_

inset. Turn on Delete Non Selected. 

Add a Scatter node to the end of the chain and set its Display Flag. 
Set the Force Total Count to 120. These will be the points used for 
instancing the jars. Later you can add more jars by increasing this 
number.

05 Add a Group Expand node to the end of the chain and 
set its Display Flag. Set the Group Name to shelf_inset. 

From the arrow next to Base Group, select shelves. 

Set the Steps to -2. This will remove the outer ring of primitives 
from the group.
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13 Select the scatter node and drag Relax Iterations down 
to 0. You will see more jars overlapping with this setting. 

Now drag Relax Iterations up to around 25. This will change the 
relationship between the jars and allow them to fit better on the 
shelves. You can again use the Global Seed slider to get the look 
you want based on these new settings.

11 Create an Attribute Randomize node and place it 
between the blast node and the scatter node. Set the 

Attribute Name to pscale. Now you can see all of the jars are 
randomly scaled. 

Set the first Min Value to 0.8 and the first Max Value to 1.2. This 
create a more appropriate range.

10 In the top bar of the Scene view, click on the Pin icon. 
Double click on the instancer node. Now you can tinker 

with the geometry network while seeing the result at the stage 
level. 

Select the scatter node and change Force Count Total to 240. Now 
the shelves have more jars on them. Drag on the Global Seed slider 
to explore different options for setting up the points.

12 Alt-drag the Attribute Randomize node and place it 
between the first attributerandomize node and the scatter 

node. Set the Attribute Name to orient then set Dimensions to 4. 
The jars are now oriented in all directions 

Set all the Min Value to 0, 0, 0, 0 and the first Max Value to 0, 60, 
0, 1. This will randomly rotate around the Y axis to add some more 
variety to the jars.

14 Go back up to the stage level. To see the whole scene, 
click on the eye icon next to ground, table and tent in the 

Scene Graph to bring them back.  

Set Visibility back to Preview with Guides to display the proxies 
before moving on to the next step. You can click on the eye icon 
next to bookcase_jars to turn off the jars if you want to optimize the 
scene while you add more props. Or you can leave them if you are 
getting good performance with the proxy geometry.
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04 Drag the Broom asset from the catalog to the Scene 
Graph list and place it in geo. In the scene, use the 

translate and rotate handles to move it into the barrel so that it is 
leaning on the edge of the barrel. Duplicate to create a second and 
move it around inside the barrel. 

Add another one outside the barrel but leaning on the side. RMB-
click on one of the broom and select geo > stick3 to change it to 
this variant

02 With the barrel still selected, press Ctrl-D to duplicate it. 
Move it beside the first one. Be sure to only translate in 

x and z. Duplicate again and move the third barrel to the other side 
of the table. 

Press and hold S to turn on Select mode and select one of the 
original barrels. Now you can move that one to tweak its position. 

03 RMB-click on one of the barrels and select geo > nolid to 
change it to the nolid variant. The Stage Manager gives 

you access to the variant feature of the assets you built using the 
component builder.

01 Add a Stage Manager node under the instance node and 
set the Display flag on the stagemanager node. In the 

Parameter pane, click on the Asset Catalog tab.  Click on the down 
arrow on the bottom of the Scene View to expand it from top to 
bottom. This will give you more space to work.

Drag a barrel (lid) from the catalog to the Scene Graph and be sure 
to drop it on the geo group so that it is under it. In the Scene view 
press t to get the Translate handle and move in x and z to place the 
barrel next to the table.

PART FIVE: 
Add Props using the Stage Manager
So far you have dragged items from the Gallery to the stage which has resulted in reference nodes in the network. You are now 
going to use the Stage Manager node to work with several assets at the same time. This node gives you access to the gallery 
and lets you place, duplicate and set variants on your assets.
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08 Press s and shift select the books and the table. In 
the Operation Control bar at the top, click on the Add 

Physics button. Now select only the books and turn on the Use 
Physics check box.

Now with the move tool drag the books down along Y. They will 
collide with each other and the table. This gives you a more realistic 
grouping of books. 

You can add more books and add them to the pile. Just be sure to 
Add physics before moving them. Turn off Use Physics at the end.

06 Add the Basket with Carpets to the shot along with 
a small basket and pot to the top of the table. Make 

sure they are all organized under the geo group. You can use the 
snapping to help with placing all of the props.

07 Add a book and using snapping to place it on top of the 
table.  Press Ctrl-J to turn off snapping. Select the book 

and press Ctrl-D to duplicate it. Move it up and a bit to the side. 
Duplicate two more times and lift the it up and off to the side 
again. 

RMB-click on the last three books and choose different variants 
using the geo submenu.

05 Drag the Cooking Pot asset from the catalog to the 
scene. Before clicking to place it, press Ctrl J. This turns 

on snapping. You can now move the pot onto surfaces such as the 
table or the barrels. Click to place the pot on top of the table.

After placing the pot, click on the center of the translate handle to 
move it some more. The snapping will still work. Move the pot on 
top of one of the barrels.

In the Scene Graph area of the Stage Manager you can see that the 
pot was not put into the geo group. Drag it down to make it a child 
of geo. This keeps your scene graph organized.

THE STAGE MANAGER
The Stage Manager node references in prims from disk and attaches them to prims in 
the scene graph tree. This serves the same function as the Reference LOP, however this 
node provides a custom interface to make it easy to reference in many files and interac-
tively place them in the tree. Referencing in many files at a time is often part of a layout 
workflow, where you start to build a scene by importing available assets and organizing 
them into a meaningful hierarchy. There are some limitations when working with complex 
USD setups therefore you should read the documentation to understand this node.
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02 Add a Box node to use as the starting point of the 
building. Set the Following:
	� Size to 15, 4, 10
	� Center to 4, 2, -8
	� Axis Divisions to 16, 12, 16

This puts the tent at the corner of the building. You can now add 
details to make it look better for the shot.

03 Tumble to the left side (from your point of view) of the 
building. Press s and then 4 to get primitive selection.  

Select the primitive at the bottom back corner then press Shift - a 
and select the whole bottom row. Press Shift and select the second 
polygon at the back of the building. Press Shift-a to select the 
whole row minus two polygons. Continue doing this until you have 
a staircase shape.

Press tab > PolyExtrude. Pull the shape out to a Distance of around 
0.8 to create a skinny staircase going up the side. These are big 
steps to suit the type of building we are creating.

01 This set could use a background element such as a small 
building. You can add that to the scene by adding a 

SOP Create node to the end of the chain. Set its Display Flag and 
rename it building. 

Double-click to dive into this network. Click on the Visibility pull 
down in the top right of the Scene View and choose Ghost Other 
Objects. This will show the props from the LOP level to help you 
position the building.

VISIBILITY MENU
When working at the geometry level of a node such as SOP Create or 
the Instancer, you may or may not want to see through to the Solaris 
level. The visibility menu at the top right of the Scene View lets you 
hide the Solaris level, ghost it or fully display it. 

You will find yourself toggling between these options as you model at 
the geometry level. It makes it easier to make creative decisions when 
you can visually reference the larger context.  

PART SIX: 
Create Background Elements
This scene would look better with some context. You are going to build a small building behind the market stall to flesh out the 
scene. This involves going to the geometry level where you can still see the Stage level to make creative decisions. You will also 
add detail to the ground surface using textures created in Copernicus to make it look like sand dunes.
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08 Set the Visibility back to Hide Other Objects. Press 
Spacebar-b to go to a four view layout then hover over 

the perspective view and press Spacebar-b again. Tumble around to 
see the bottom of the building.

Press 3 to get edge selection and select the bottom edge of the 
back opening. Press Shift-A and click on the other side to get 
the whole profile. Press tab > PolyBridge. Now select the front 
openings profile and press Enter. 

Set Divisions to 15 to match the sides of the building.

06 Set the Visibility back to Ghost Other Objects. Press 
Spacebar-b to go to a four view layout then hover over 

the front view and press Spacebar-b again. Add another Blast node 
to the network and set its Display Flag. Press the arrow next to 
Group and box select the polygons shown here to the right of the 
tent. Press Enter to select. This will create an opening on both sides 
of the wall.

07 Press 2 to get point selection and select the points at 
the top of the opening. Press t to get the Move tool and 

move the points up to arch the opening. 

On the Edit node, set the Soft Radius to around 1.2 to make sure 
the other points move with it. 

05 Set the Visibility to Hide Other Objects. This will make it 
easier to work with the bottom polygons.

Add a Group node and set the Group Name to base. Turn off Base 
Group > Enable and turn on Keep by Normals > Enable. Set the 
following:

	� Direction to 0, -1, 0
	� Spread Angle to 30

Get the Handle tool to see the primitives that belong in the group.

Add a Blast node and set its Group to base. This will delete the 
primitives on the bottom of the building.

04 Tumble around to see the top of the building. Select the 
primitive at the back of the building behind the stairs. 

Press Shift-a and click on the four corners and then back along the 
side of the stairs. 

Now press the Ctrl key and click to remove the polygons shown 
here. Every second one but leave two near the corners. 

Press tab > PolyExtrude. Pull the shape out to a Distance of around 
0.5 to turn the top of the building into a battlement.

Box 
Select
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10 Add a UV Flatten node to the end of the chain. Set its 
Display Flag. Set the following:
	� Seams to edges

Click on the Repack button in the Operation Controls bar. You will 
see in the UV View how the geometry is laid out. This will work fine 
because later you will be adding a noise texture to add more detail 
to the look of the building.

11 Add a PolyBevel node to the end of the chain. Set its 
Display Flag. Set the following:
	� Group to edges
	� Distance to 0.05
	� Fillet > Divisions to 2

The building needs a bit of noise. Add a Mountain node and set 
Amplitude to 0.075. Add a Null node and name it BUILDING_OUT.

09 Add a Group node and set the Group Name to edges and 
Group Type to Edges. Turn off Base Group > Enable and 

turn on Include by edges > Enable. Set the following:
	� Min Edge Angle to 60
	� Max Edge Angle to 95

Get the Handle tool to see that only the right angle edges have 
been added to the group.

MODELING IN SOLARIS
This lesson began with you converting existing bgeo files into USD. By modeling directly 
in the SOP Create node, you are automatically generating USD that is part of your scene 
but won't be saved to disk until you export out the completed scene assembly. Modeling 
in context allows you to make key creative decisions.

Once this model is fleshed out, you could send the geometry network to the modelling 
team who could put more time into refining the asset then use the Component Builder 
to export it to USD. It can then be layered back into the scene.

12 Go back to the stage level and create a Quick Surface 
Material and place it to the side. Rename it building_mtl. 

Add a Merge node after the building node and merge the building_
mtl node into it. 

Add a Material Linker node to the end of the chain. Open the /
materials section of the Material List and drag the building_mat over 
to the Rules section. Find the building in the Geometry Tree and 
drag it to the Material section of the rule. 
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17 Add a Mountain node and set the Amplitude to 1. This 
will create a bumpier surface for the ground. But we don’t 

want any points to go below 0. 

Add a Group node and set Group Name to belowground. Turn 
off the Base Group > Enable and turn on the Keep in Bounding 
Regions > Enable. Set the following under Bounding Box:

	� Size to 100, 1, 100
	� Center to 0, -0.5, 0

Add a Flatten node and set Group to belowground. Now any points 
that were below 0 are lifted up to 0.

15 Pin the Scene View to the stage level. Double-click on 
the COP Network node to dive into it. 

Here you will find a bump_height node being fed by a checker node. 
Delete the checker node and press tab > Fractal Noise. Place this 
node down and connect the noise output to input1 on the bump_
height node.

Check out the Scene View to see the effect of the texture. It needs 
some more intensity. On the fractalnoise node, set Amplitude to 10. 
This adds a bumpy look to the surface of the building.

16 Now the ground surface looks a little plain Go back to the 
stage level and double-click on the ground node to dive 

into it. On the ground node set the following:
	� Size to 50, 50
	� Rows to 50
	� Columns to 50

Add a UV Project node and set the following:
	� Rotate to 90, 0, 0
	� Scale to 2, 2. 0

13 Add a Karma Physical Sky node to the end of the chain 
and set the following:
	� Solar Altitude to 60 
	� Solar Azimuth to 120

Set the Scene View display to Karma XPU. This will help you 
evaluate the material choices for the building.

Select the building node and then click on the Import from SOPS 
tab and under Geometry Handling turn on Treat Polygons as 
Subdivision Surfaces. This will ensure micropolygon subdivisons at 
render time.

14 Select the building_mtl node and set the Base > Color to 
0.25, 0.15, 0.05. Set Specular > Roughness to 0.8. 

Scroll down to the Bump section and set Bump Style to Height.  
Click on the button on the left of Bump Height Map and choose 
Set or Create then click on the Create COP Texture  button. This 
adds to a COP Network off to the side. 
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20 Pin the Scene View to the stage level. Double-click on 
the ground_mtl_maps COP Network node to dive into it. 

Delete the checker node and press tab > Worley Noise. Place this 
node down and connect the dist1 output to input1 on the bump_
height node.

The texture needs some more fine detail. On the worleynoise node, 
set Element Size to 0.01 and Jitter to 1.0. This adds a bumpy look 
to the surface of the building. Go up to the stage level and on the 
ground_mtl node set Bump Scale to 0.01.

21 Create a USD ROP and place it to the side. Rename it 
ground_mtl then connect it with the materiallinker node. 

IMPORTANT: Make sure the karmaphysicalsky node is not part of 
this chain. You want to give the lighters a clean slate.

Set Output File to $HIP/usd/market_scene.usd. Click Save to Disk. 

Save your scene file.

19 Create another Quick Surface Material and feed it into 
the building_mtl node. Rename it ground_mtl. 

Select the Material Linker node and from the /materials section 
drag the ground_mat over to the Rules section. Find the ground in 
the Geometry Tree and drag it to the Material section of the rule. 

Select the ground_mtl node and set the Base > Color to 0.35, 0.22, 
0.08.  Set Specular > Roughness to 0.8. Scroll down to the Bump 
section and set Bump Style to Height. Click on the button on the 
left of Bump Height Map and choose Set or Create then click on 
the Create COP Texture  button.  

18 Add a Subdivide node to smooth it out a little then add a 
Null node and name it GROUND_OUT. 

Go up to the stage level. Select the ground node and then click on 
the Import from SOPS tab and under Geometry Handling turn on 
Treat Polygons as Subdivision Surfaces. In the Scene view you can 
see the ground looks more organic.

There is some overlap between the ground and some of the tent 
props. It looks like the sand has blown over the stall a bit.

PROCEDURAL TEXTURES WITH COPERNICUS
The new Copernicus context is a 2D and 3D GPU image processing framework that provides 
real-time image manipulation and is ideal for tasks such as building texture maps and setting 
up Slap Comps. When working with the Quick Surface Material, you can quickly set up a COP 
Network for building up textures that plug right into the material. 

This context is currently a beta feature in Houdini and should be used with caution in  
production. It is good for you to learn about it now so you can explore what is possible.
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04 Add a Null node and name it SHOT1. Now press tab > 
Insertion Point and add this node between the camera 

and the null nodes. Rename the node Edits1 and on the node 
change the Name to `$OS` which uses the node name as the name 
of the insertion point.

Alt-drag and place the node between the first insertion point and 
the null node. Rename this node to Lights1. 

These nodes will be helpful when you start making edits to the 
shot. They will allow you to work in the Scene View while nodes get 
placed where you need them in the network. 

02 In the Scene view, use the view tools to get the right 
angle then from the No Cam menu in the top right 

corner, choose New Camera. 

You can use the camera handles in the center of the view to adjust 
the view. Or you can go to the right side of the Scene View, click 
on the  Lock camera to view button. Now use the View tools 
[Spacebar-LMB/MMB/RMB] to tweak the position the camera.

Click on the View tab and set the Focal Length to 35. Now use the 
view tools to reframe the camera to see more of the scene.

03 Change the Primitive Path on the camera to /cameras/
camera_main. This will ensure that the camera name is 

not tied to the node name. 

The name change will make you lose the camera. Select camera_
main from the Camera menu in the top right of the Scene view.

When you finish, toggle off the Lock Camera button in order to 
avoid losing your chosen camera view. You may want to tumble 
around later to make adjustments to the layout and you don’t want 
the camera to come with you. 

01 Select File > New. Select File > Set Project.  Find the 
market_lesson directory and press Accept. Change your 

desktop to Solaris. Select File > Save As. Click on $JOB to get the 
project directory and set File to market_shot_layout.hip and then 
press Accept. You are going to work as a layout and lighting artist.

In the Network view, press tab > Sublayer. Click on the file chooser 
next to File and get the /usd/market_scene.usd file. You will now see the 
whole market scene. In the Scene Graph, you will see that the structure 
of the scene hasn't changed. This will allow artists to work with the 
scene without altering the contents of the market_scene.usd file.

PART SEVEN: 
Shot Layout and Lighting
You are now going to start a new scene where you will layout two shots as a Shot Layout/Lighting artist. You will learn how to 
tweak the elements of the scene to suit each shot and how to use insertion nodes to make it easier to add nodes to the right 
place in a network. Each shot will have a unique look using the same base assets you set up in scene assembly. 
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07 Press s and click on the basket with carpets. Press t to get 
the Move handle and move the basket back along the Z 

axis so you can see the barrels better.

Press s and click on the small basket on the table. Press Ctrl-j and 
use the Move handle to move the basket to one of the steps on the 
background building.

08 In the Scene View,  Click on the Insertion Point menu 
and choose Lights1.  

Press tab > Karma Physical Sky. This node is now placed just above 
the Insertion point rather than at the end of the chain. 

From the Persp menu in the Scene View, choose Karma XPU. You 
can now preview this shot in Karma.

To create a daylight scene, set the following:
	� Solar Altitude to 45
	� Solar Azimuth to around 160

06 Set the Display Flag on SHOT1. Because both cameras 
are named camera_main the Scene view will update 

when you choose the first node chain.

In the Scene View,  Click on the Insertion Point menu and choose 
Edits1.  Get the Select tool and click on the ground surface. Press 
tab > Edit. This node is now placed just above the Insertion point 
rather than at the end of the chain. 

Press e to get the Scale handle and scale along the Y axis to make 
the surface bump less pronounced.

05 Select the camera1, Edits1, Lights1 and SHOT1 nodes 
and Alt drag them to the right. This creates a camera2 

that still has a prim name of camera_main, a duplicate of the others 
nodes. 

Set the Display Flag on SHOT2 and select the camera2 node. Click 
on the  Lock camera to view button. Now use the View tools 
[Spacebar-LMB/MMB/RMB] to tweak the position the camera 
to look at the shot from the other side. 

When you finish, toggle off the Lock Camera button in order to 
avoid losing your chosen camera view. 

INSERTION POINTS
You can have multiple insertion points in a network and switch between them using 
the menu in the viewer. When you create new LOP nodes in a view, Houdini inserts 
them above the active insertion point instead of at the end of the network. 

This is ideal for multi-shot editing workflows, where artists working on a shared file 
in the Scene view can choose the a specific insertion point for their department to 
make sure the nodes are created in the right part of the network. For example, you 
could have insertion points for Lighting, Camera, and Layout. 
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12 Press s and click on the barrel with nolid. Press t to get the 
Move handle and move the basket in front of the table 

then press r to get the Rotate handle and rotate it to look buried in 
the sand. Make sure you can see into the barrel.

Select and move the books and pots to put them into the sand 
or toppled over on the table. You might want to use Ctrl-j to help 
place them on the sand. Make a mess of things. 

10 Set the Display Flag on SHOT2. In the Scene View,  Click 
on the Insertion Point menu and choose Edits2. Go back 

to Houdini VK for the viewport Display.

Get the Select tool and click on the ground surface. Press tab > Edit. 
This node is now placed just above the Insertion point rather than 
at the end of the chain. 

Press e to get the Scale handle and scale along the Y axis to make 
the surface bump more pronounced until it looks like the scene is 
buried in sand.

11 In the Scene View, click in the sky to deselect the ground 
and then press Tab > Prune. Press Enter with nothing 

selected. This will add a prune node into the network above the 
Insertion point.

In the Parameter pane, set the Primitive Pattern to:

 /geo/broom* /geo/bookcase_jars

These items will now be removed from the scene. You are not 
deleting them but rather you are making them invisible. Imagine 
that they were lost in the storm.

09 In the Scene View, press tab > Light. This adds a light 
node just before the insertion point.

Press Enter to place it at the origin then use the handle to move 
it into the tent above the ground. This will illuminate the shelves 
and the inner part of the tent. Leave the intensity set to 1. You can 
adjust this later.

On the Display Options bar, you can click on the Display Light 
Guides button to turn it off.

You have now made specific edits to the first shot and set up lights. 
Now let's take a look at the second shot.

PRUNING
When working with USD you cannot delete items in the active layer. Instead you can use a 
Prune node to either hide or deactivate them. Deactivated prims and their children will not 
be traversed or processed by USD functions or LOP nodes. Children of deactivated primitives 
don’t appear in the Scene Graph Tree. Hidden prims and their descendants are still processed 
by USD functions and LOP nodes, but are not shown in the viewport or rendered.

You are going to hide some elements from the Scene Assembly to create a more barren  
second shot. You haven't changed the incoming USD file, you have just pruned some items,
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15 In the Scene View, press tab > Karma Fog Box. In the 
Parameter pane, set the following:
	� Translate to -5, 5, -5
	� Scale to 20, 10, 20

You can also go to Houdini VK display and zoom out to view the 
handles on the fog box. You can use these if you want to tweak it 
further.

16 Go back to the camera_main and turn Karma XPU back 
on. You can now see the effect of the fog on the shot. 

The light inside the tent is creating a nice effect as i illuminates the 
volume. 

Save your work. Next you will dig deeper into rendering the two 
shots. 

14 In the Scene View, press tab > Light. This adds a light 
node just before the insertion point.

Press Enter to place it at the origin then use the handle to move it 
into the tent above the ground. This will illuminate the shelves and 
the inner part of the tent. Set the Color to a yellow color.

Press tab > Light. This adds another light node. Move this one 
inside the barrel on its side. Set its Intensity to 0.5 and change its 
Color to orange. Something is going on in there that needs to be 
illuminated.

13 In the Scene View,  Click on the Insertion Point menu and 
choose Lights2. 

Press tab > Karma Physical Sky. Set the following:
	� Intensity to 1.5,
	� Solar Altitude to 2
	� Solar Azimuth to around 200. 

Go back to Karma XPU display. This creates more of a late evening 
look.

KARMA XPU VS CPU
Karma has two render engines designed to produce the same high quality results:

Karma XPU takes advantage of both the GPU and CPU simultaneously to ensure full use of 
all computers resources. This renderer works exclusively with MaterialX shaders. Karma XPU 
is the faster renderer and is production-ready for a wide range of uses.

Karma CPU runs entirely in software on the CPU and is able to render both MaterialX shad-
ers and legacy shaders built using VEX. Karma CPU can access a few features not in XPU.
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02 On the Image Output > AOVs tab, scroll down and turn 
on the following render layers:
	� Diffuse > Combined Diffuse
	� Reflections > Combined Glossy Refection
	� Ambient Occlusion > Ambient Occlusion
	� Utility > Depth (Camera Space)

These will be generated at render time and be available for 
compositing purposes.

03 Click on the Show Snapshot Strip button on the bottom 
of the toolbar to turn it on. Make sure you are looking 

through the camera_main and click on the Snapshot button. 

In the Scene view tab section, click on the + sign and choose Solaris 
> Render Gallery. You can now click on the snapshot icon and 
inspect the image.

In the top bar you can click on the C menu and choose from the 
different AOVs. Here is the Ambient Occlusion pass.

01 Up until now you were using viewport settings to 
render. You can access them with the d key in the scene 

view.  Now you will add a karmarendersettings node which will add 
settings to your node chain.  

In the Network View, press tab > Karma to add a Karma Render 
Settings and USD Render ROP node. Wire them into the end of the 
SHOT 1 chain. Set the Display Flag on the karmarendersettings node 
and set Camera to /cameras/camera_main/ and Engine Settings to 
XPU parameters. On the Image Output > Filters tab set Denoiser 
to nvidia Optix Denoiser to turn the denoiser back on.

04 In the Scene View,  Click on the Insertion Point menu 
and choose Lights1. 

Press tab > Light Mixer then press Enter to place the node just 
before the insertion point. This will create a special panel in the 
Parameter pane which has a list of lights on the left side. 

Click on the Sliders tab then Drag the existing lights from the list to 
the area on the right. This node lets you layer edits to the existing 
lights without making changes to original settings. This way if you 
don’t like your edits it is easy to go back to what you had or branch 
off and try a different setup with a different Light Mixer node.

PART EIGHT: 
Render Shots with Karma XPU
Now that the two shots are ready, you can refine the rendering. Using Karma XPU, you will use render settings and set up AOVs 
- render layers for the shot. You will then Snapshot different lighting setups and compare the results. Once the shots are ready, 
you will render them to disk.
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06 Go back to the Render Gallery. Select the first snapshot 
and press the A button then click on the second one and 

press the B button. In the top bar, drag on the slider to explore the 
difference between the images.

Go back to the Scene view. RMB-click on the older snapshot and 
choose Revert Network to this Snapshot. Now you can see the 
original rendering. RMB-click on the newer snapshot and revert it 
back. The Light Mixer node is gone. You can explore different looks 
for your shot and use snapshots to capture and retrieve them. 

07 Select the karmarendersettings and usdrender_rop1 nodes 
and Alt drag them to make copies. Feed the SHOT2 node 

into these new nodes. Use the Snapshots and the Render Gallery 
to tweak the second shot. 

When you are ready to render out the two shots, go to the 
karmarendersettings node and set up the Output Picture name then 
set the Resolution. Then go to the usdrender_rop node and click 
Render to Disk. 

To watch the progress of your rendering, click on the + sign and 
choose Render Scheduler.

05 Click on the Star icon to Solo each light to determine 
each of their contribution then tweak Exposure to adjust 

the lighting. You can click on the icon above the intensity bar and 
from the pop-up set a Max value that works for your shot.  

When you are finished be sure to turn off the Solo button to see 
all the lights. Once the rendering is complete, press the Snapshot 
button. 

CONCLUSION
In this lesson, you learned how to use the Solaris Lookdev, Layout and Lighting tools to create a market scene us-
ing existing assets. The Solaris/LOPS context lets you work with USD natively using procedural nodes to manage 
key USD concepts. You learned how one artist can publish USD layers or files that can be picked up by the next 
artist. Changes can be added non-destructively to set up a scene or 
refine a shot. 

Along the way you worked with the Component 
builder to create first-class USD assets, the Stage 
Manager to bring in and manage the assets and 
instancing for efficiently setting up multiple 
assets such as the jars on the bookcase.

Solaris is the context for look develop-
ment in Houdini and this lesson 
was designed to give you a good 
overview of some of its key 
strengths.
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